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Tabs3 Billing Statements Guide

Purpose of Guide
This Statements Guide covers everything you need to know about Tabs3 Billing statements. This
guide includes information on preparing, generating, finalizing, and updating statements, and more.

A separate Billing Methods Guide includes information on the various client billing methods that
are available in Tabs3 Billing. A separate Statement Formatting Guide includes information for
customizing the look of your Tabs3 Billing statements. Additional guides for separate software
features are also available on our Web site at:

Tabs3.com/support/docs.html

Billing Cycle Overview
Billing in Tabs3 involves several steps. The following provides a general overview of the Tabs3 billing
cycle.

Configure the Client Settings must be defined for the client to determine how
they will be billed, and where statements will be sent to.

Add Fees, Costs, and Payments Data entry in Tabs3 Billing is performed in the Fee, Cost,
and Payment programs. Fees and costs can also be
entered via PracticeMaster. Timekeepers enter their work
over the course of the billing cycle, specifying the date,
transaction code, and hours worked for each fee, and the
date, transaction code, and units for each cost. Data entry
is done on an ongoing basis throughout the billing cycle.

Run Reports andMake
Adjustments

Some billing methods require that transactions be
adjusted prior to billing, such as flat fee billing and split
billing. Other billing types require use of the Write-
Up/Write-Down program. More information on
adjustments can be found in the Billing Methods Guide
as well as in the Billing Adjustments Guide. Once you
have completed your adjustments, you can generate pre-
bills for the adjusted clients as needed for review.
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Generate Pre-Bills Once you are ready to start generating bills, it’s time to
make sure the data was entered correctly. You can use
either Draft Statements or the Detail Work-In-Process
Report to provide pre-bill information for your
timekeepers to review for accuracy. Additionally, you can
use the Pre-Bill Tracking feature in Tabs3 Billing to track
which pre-bills have been returned.

Review Pre-Bills After you have generated your pre-bills, you can distribute
them to the appropriate timekeepers. After the
timekeepers return the approved statements, you can
make any necessary edits. Once all the necessary changes
have been made, you can proceed to the next phase.

Generate Final Statements Once all of the information on your pre-bills has been
approved, it’s time to run final statements. Running final
statements begins the process of moving the transactions
included on the statement from a status of “work-in-
process“ to a status of “billed“.This is important because
payments can only be applied to billed transactions.

Update Statements Updating statements completes the process of moving
transactions from a work-in-process status to a billed
status. Once a statement has been updated, you can apply
payments to the billed transactions. Additionally, the
Update Statements process applies any previously entered
unapplied payments.

Distribute Statements Once your statements have been updated, you can
distribute them to their respective clients. Methods of
distributing statements can include mailing printed
statements, emailing electronic files, or submitting bills
electronically via the Tabs3 Taskbill software.

Training Videos
You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Statements Overview Video
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Client Configuration
The first step to ensuring your clients are billed as desired is configuring the client settings that
affect when statements are generated, and whether they are printed or emailed.

Billing Frequency
Billing frequencies are used to define how often a client
is billed (monthly, quarterly, etc.). The billing frequency
can be used for selecting batches or groups of clients
when running statements and reports. The billing
frequency is assigned to clients on the Setup tab of the
Client file. Examples of billing frequencies include
“monthly,” “quarterly,” “annually,” “standard,”
“contingency,” “hold,” etc.

Figure 1, Client File - Billing Frequency

▶ To change the Billing Frequency

1. From the Filemenu, select Open and click Client.

2. Select the desired Client ID.

3. Click the Setup tab.

4. Select the desired Billing Frequency.

5. Click to save the client.
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Release to Bill and Bill on Demand
The Release To Bill and Bill On Demand check boxes on the Billing Preferences tab of the Client file
determine whether a statement will be included the next time statements are generated.

Release To Bill If the Release To Bill check box on the Billing Preferences
tab of the Client file is cleared, then the client will not have
a statement printed regardless of whether the client has a
previous balance or work-in-process. This check box must
be selected in order to have a statement printed.

Bill On Demand if the Bill On Demand check box is selected, the Release
To Bill check box will automatically be cleared when the
Update Statements program is run. This is done to prevent
the client from automatically being billed the next time
batch statements are printed. Clients with a status of Bill
On Demand are usually billed by running single
statements instead of being billed in a batch.

Figure 2, Client File - Billing Status

▶ To release a client to bill

1. From the Filemenu, select Open and click Client.

2. Select the desired Client ID.

3. Click the Billing Preference tab.

4. Select the Release to Bill check box.

5. Click to save the client.
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Statement Delivery Options
Statements can be set up to
be printed and mailed, saved
as a PDF and emailed, or
both. Statement Delivery
Options are specified on the
Billing Preferences tab of the
Client file in individual Bill To
records. You can double-click
a Bill To record in the table to
review or edit it.

Figure 3, Client File - Billing Preferences tab

Bill To Records
Bill To records consist of information associated with a recipient of a client’s mailed or emailed
statement. Each Bill To record is associated with a contact (except when associated with a secure
client). Bill To records include additional billing information not stored in the Contact file, such as
whether a statement will be mailed and/or emailed, which mailing address or email address will be
used, whether an Attention line is included, and more.
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An additional Bill To record
can be added to send
statements to a different
contact. Each client can have
up to two Bill To records.

Figure 4, Bill To Record window

▶ To add a Bill To record

1. From the Filemenu, select Open and click Client.

2. Select the desired Client ID.

3. On the Billing Preferences tab, in the Statement Delivery Options section, click the Add
button.

4. Select a Bill To Name.

5. Enter a Description to help identify this Bill To Record.

6. Select whether the contact will receive statements by mail, email, or both.
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7. Select the Statement Address and/or Email Delivery Options based on the delivery selection.

8. Click OK to save the Bill To record.

You can change whether a statement is mailed or emailed at any time.

▶ To change whether a statement is mailed or emailed

1. From the Filemenu, select Open and click Client.

2. Select the desired Client ID.

3. On the Billing Preferences tab, in the Statement Delivery Options section, select the
desired Bill To Name.

4. Click the Edit button.

5. In the Statement Delivery Options section, select or clear the desired options.

6. Click OK to save the Bill To record.

Figure 5, Bill To Record - Statement Delivery Options

More Info: Additional information on Client settings that affect billing and statements can be
found in the Billing Methods Guide and the Statement Formatting Guide.

Integration with Trust Account Software
If you are integrating with Trust Accounting Software (TAS), trust information can be included on
statements. Additionally, Tabs3 Billing and TAS can be configured to generate automatic payments
from TAS that are included on statements. For more information including how to configure these
features, refer to the Integration Guide.
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Training Videos
You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Client Overview Video
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Data Entry
When entering transactions, the Bill Code and Status fields determine whether the transaction is
billed or shown on the statement.

Bill Code
The Bill Code indicates whether the transaction is billable or non-billable (i.e., no charge), and the
printing status.

The following Bill Codes are available for fee and cost entry:

l Billable/Printable
l Non-Billable/Non-Printable
l Non-Billable/Printable
l Billable/Non-Printable
l Billable/Always Print

Non-printable transactions will not be shown on a statement regardless of whether they are billable
or non-billable. Likewise, non-billable transactions will not incur a charge on the statement,
regardless of whether they are printable or non-printable. Bill Codes are not available for payments.

The majority of transactions entered
are Billable/Printable.

Figure 6, Fee File - Bill Code

Status
The Status field determines whether the transaction is eligible
to print on a statement. It also indicates whether a transaction
has been shown on a final statement but has not yet been
updated.

Figure 7, Fee File - Status
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Hold Puts a transaction on hold and prevents the entry from
being billed until it is changed to a Print status. This status
is available for Fee, Cost, and Payment entry.

Print Allows a transaction to print on a client’s statement. New
entries automatically default to Print. This status is
available for Fee, Cost, and Payment entry.

Update Indicates that the transaction has been final billed and is
ready to be updated by the Update Statements program.
You will not be allowed to edit the Status field when
Update is shown. If you want to change this field, you
must first unbill the statement. This status is available for
Fee, Cost, and Payment entry.

Save Has the same function and print status as Print but the
transaction is saved after it has been shown on a final
statement and updated. Instead of being deleted after
printing on a statement, saved transactions remain in the
fee file for repeated billings until they are deleted or
changed to Print. This status is available for Fee and Cost
entry.

Save/Update Indicates that the transaction is a saved transaction that
has been final billed and is ready to be updated by the
Update Statements program. You will not be allowed to
edit the Status field when Save/Update is shown. If you
want to change this field, you must first unbill the
statement. This status is available for Fee and Cost entry.

The majority of transactions are entered with a status of Print.
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Statement Preparation
Before generating statements, perform the following steps.

1. Make sure Release To Bill is selected for all clients for which a statement should be printed
(page 4).

2. Make sure all transactions to be included on a statement are set for Print and not Hold (page
9).

3. Optionally run draft statements or Work-In-Process reports to review work that needs to be
included on statements (page 12).

4. Optionally use the Reorder Fees utility to change the order in which fees with the same date
are displayed on statements (page 12).

5. Optionally make adjustments (Write-Up/Down, Flat Fee, Split Fee) (page 11).

Making Adjustments
Depending upon how your clients are set up, you may need to run one or more of the following
utilities prior to generating statements:

Write-Up/Write-Down The Write-Up/Write-Down Fees and Costs program allows
you to write-up or write-down total unbilled fees, costs, or
hours for a client for a range of timekeepers, transaction
codes, categories, or dates for a client prior to billing.
Write-ups/write-downs can be adjusted to a specified
amount or by a specified percentage.

Adjust Flat Fee Clients The Adjust Flat Fee Clients program allows you to adjust
fee transactions in work-in-process to equal the flat
amount assigned in the Client file. The Adjust Flat Fee
Clients program only adjusts fee transactions for clients
whose Billing Rate Code is “0” (zero). Cost transactions are
not adjusted.

Perform Split Billing The Perform Split Billing program allows you to split the
fee and cost transactions in work-in-process to equal the
split fee percentages defined on the Split Billing tab of the
Client. This program will copy the transactions to the split
clients and adjust the Hours and Amounts of the specified
transactions.
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More Info: Additional information on these utilities can be found in Tabs3 Billing Help, the Billing
Methods Guide, and the Billing Adjustments Guide.

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
theHelp | Training Videosmenu and at Tabs3.com/t3video.

Flat Fee Billing Video

Split Billing Video

Write-Up/Down Fees and Costs Video

Reorder Fees
Menu: Statements | Statement Preparation | Reorder Fees
Home: All Actions | Statement Preparation | Reorder Fees

Depending on the reference number that is assigned when fees are entered, the order in which fees
are shown on the statement may not be as desired. For example, if a fee for “Review document” is
entered and assigned a reference number of 1, and then the fee for “First draft of document” is
entered and assigned a reference number of 2, the statement could show that the document was
reviewed before the first draft was created. The Reorder Fees utility allows you to change the order in
which fees with the same date are displayed on statements by moving fees up and down within the
list.

▶ To reorder fees on a statement

1. From the Statementsmenu, select Statement Preparation and then click Reorder Fees.

2. Select the desired Client ID.

3. Select the transaction you want to move and then click theMove Up orMove Down button.

Note: Moving fees up or down via the Reorder Fees utility changes the reference number of the
fees.

Pre-Bills: Detail WIP Report vs. Draft Statements
Most firms run Pre-Bills one of two ways: printing a Detail Work-In-Process Report (Detail
WIP Report), or printing Draft Statements. Both of these options update the Pre-Bill Tracking
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program (page 22); however, each option offers different features. The Detail Work-In-Process
Report provides a list of transactions in a report format that includes additional detailed information
for each transaction, whereas draft statements provide a list of transactions in statement format.

Work-In-Process Reports
Menu: Reports | Work-In-Process | Detail Work-In-Process

Reports | Work-In-Process | Summary Work-In-Process
Reports | Work-In-Process | Aged Work-In-Process

Home: All Actions | Statement Preparation | Detail Work-In-Process
Statement Preparation | Summary Work-In-Process
Statement Preparation | Aged Work-In-Process

Work-in-Process reports are valuable tools that show all unbilled fees, costs, and payments. Work-
in-Process reports can be run in a detailed or summary format, or to review aged Work-In-Process.
Tabs3 Billing includes the following Work-In-Process reports:

Detail Work-In-Process The Detail Work-In-Process Report shows the detail of all
fees, costs, and payments entered for the client. The
detailed report can be used to review work-in-process
prior to billing. Some firms use Detail Work-In-Process
Reports in lieu of running draft statements.

SummaryWork-In-Process The Summary Work-In-Process Report shows the client’s
previous balance and totals for any fees, costs, or
payments in work-in-process. A current balance is
calculated and shown. The client funds balance is shown
as well. This report allows for a quick review of the client’s
status.

AgedWork-In-Process The Aged Work-In-Process Report shows the age of all
unbilled charges by client.

▶ To run aWork-In-Process Report

1. From the Statementsmenu, select Statement Preparation and then click the desired Work-
In-Process report.

2. Select the desired report criteria.

3. Click OK.
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Detail & Summary WIP Reports Video
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Generating Statements
Statements are run using the Generate Statements program.

Generate Statements Program
Menu: Statements | Generate Statements
Home: All Actions | Statements | Generate Statements

The Generate Statements program allows you to print an individual client’s statement or a batch of
clients’ statements in draft or final mode. The Generate Statements program includes a Client tab, a
Transactions tab, an Options tab, and a Sort tab.

Figure 8, Generate Statements
Client tab

Figure 9, Generate Statements
Transactions tab
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Figure 10, Generate Statements
Options tab

Figure 11, Generate Statements
Sort tab

Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Transactions tab The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs or payments), date, transaction code, working
timekeeper, category, and cost type.
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Options tab The Options tab allows you to specify the statement date
and the minimum fee, expense, and advance amounts to
be billed. You can select if you want to print reminder
statements or statements for clients with current work.
You can include only clients with past due amounts
greater than a specified number of days. If you number
statements at the firm level, you will be prompted to enter
the beginning statement number. If you print draft
statements, you can elect to print reference numbers for
the individual transactions, update pre-bill tracking
information, and select whether you want billing notes
and instructions included. You can select whether you
want statements for task based billing clients to include or
exclude task based billing information. You can specify
the number of copies you want printed, and whether or
not you want to include Statement Run Totals and a
Criteria Page. If generating PDF files for statements, you
can elect to generate individual PDF files for the statement
run. You can select to print cover statements only. If
desired, you can override individual statement template
options or specify a different statement template for a
particular batch of statements.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

When draft statements are displayed using the Preview option, you can drill down to individual
client, fee, cost and payment records allowing you to edit data directly from the Preview window.
When final statements are printed or displayed using the Preview option, email statements are sent
to the Email Statements window for review.

Some firms will run batches of statements by timekeeper.

▶ To generate a batch of statements for a specific primary timekeeper

1. From the Statementsmenu, click Generate Statements.

2. From the Client tab, select a Primary Timekeeper range.

3. From the Options tab, select to print a Draft or Final statement.

4. Select any other desired options.

5. Click OK.

- 17 -



Tabs3 Billing Statements Guide

Tip: You can generate batch statements for all timekeepers at the same time and have them sorted
by primary timekeeper. To do this, select a Report Order of Primary Timekeeper on the Sort tab.

Which Clients Will Have Statements Printed?
When statements are run, the options selected in the Generate Statements program as well as a
client’s previous balance, work-in-process, and client information settings determine if a statement
will be processed.

l Generally, clients with a previous balance or work-in-process that is released for billing will
have a statement processed.

l You can select to include clients with work-in-process, without work-in-process, or both. If
desired, reminder statements can easily be printed that will not include current work-in-
process.

l If the Release To Bill check box for a client is cleared, then the client will not have a
statement printed regardless of whether the client has a previous balance or work-in-
process. This check box must be selected in order to have a statement printed. Keep in mind
that if the client’s Bill On Demand check box is selected, the Release To Bill option will
automatically be cleared when the Update Statements program is run. This occurs in order to
prevent the client from automatically being billed the next time batch statements are printed.
Clients with a status of Bill On Demand are usually billed by running single statements
instead of being billed in a batch. (Exception: Clients whose Bill On Demand check box is
selected and Release To Bill check box is cleared will have a reminder statement generated.)

l If desired, you can also specify threshold billing options at the client level or when printing
statements so that only clients with work-in-process that exceeds a specified amount will be
billed.

l When generating email statements for clients, the statements are output to the Email
Statements window when running final statements. However, if a client is configured for
both email and mail statements, the statement is printed and sent to the Email Statements
window. Draft statements are not sent to the Email Statements window.

More Info: A checklist of potential reasons why a statement doesn’t print can be found in
KB Article R10004, “My Statement Doesn’t Print“.
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Using Report Definitions to Define Batches
Tabs3 Billing allows you to save all of the parameters specified for statement runs and individual
reports as report definitions. This feature saves time when running statements on a regular basis by
streamlining the process of selecting the options.

When saving a report definition, Tabs3 Billing also allows you to specify that the report definition
should be used as the default for the report. The next time any user selects the report, the options
from this report definition will be used by default.

The reports that allow you to create and use report definitions include two buttons in the report
window: the Load button and the Save button.

Load The Load button can be used to retrieve a previously saved
report definition for statements. The Report Definition List
(Figure 12) will be displayed, allowing you to select a
report definition.

Save The Save button can be used to save the specified options
as a report definition. The Save Report Definition window
will be displayed, allowing you to specify a report
definition name and description.

Figure 12, Report Definition List
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Draft vs. Final
One of the most important concepts in Tabs3 Billing is the
difference between “draft” statements and “final”
statements. When running statements, the Options tab is
used to specify whether you are running draft or final
statements.

Figure 13, Generate Statements window
Draft vs. Final

Draft Statement Draft statements do not alter any information in the data
files and can be run at any time. Because of this, multiple
draft statements for a client can be run at any time during
the billing cycle as needed. When draft statements are
displayed using the Preview option, you can drill down to
individual client, fee, cost, and payment records allowing
you to edit data directly from the Preview window. Many
firms will select the option Print Reference Numbers to
make it easy to quickly look up transactions for editing
purposes.

Final Statement Final statements can also be run at any time; however,
when final statements are run, the Status field is changed
to U-Update for each transaction included on the
statement. This indicates that the entry has been billed and
is ready to be updated by the Update Statements program.
This “U” can be seen on the Detail Work-In-Process
Report, the Transaction File List and in the Status field
when editing the transactions. You can edit a transaction
that has U-Update in the Status field, but you should
reprocess another final statement that reflects the
changes. You cannot delete a transaction that has U-
Update in the Status field. You must first “unbill” that
client and then you will be allowed to delete the
transaction.
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The changes that are made to the data files by running
final statements are not permanent until the Update
Statements program is run. This means that you can run
final statements multiple times. However, whatever
information was shown on the last final statement for the
client is the information that is updated by the Update
Statements program.

Reminder Statements
Reminder statements can be sent to clients to encourage
timely payment of past work. Reminder statements are
generated by selecting the Reminder Statement check box
on the Options tab of the Statements program. You can
select whether you want to use a detail or summary format.
A summary reminder statement includes the client’s
previous balance and any unprocessed payments, but does
not include current fees and costs. A detail reminder
statement includes this same information as well as a history
showing amounts billed and due for each outstanding
statement.

Figure 14, Generate Statements window
Reminder Statements

Previous Balance $2,205.75

Stmt Date Stmt # Billed Due
08/26/2018 7587 75.00 75.00
09/25/2018 7591 131.00 131.00
10/26/2018 7595 1,999.75 1,999.75

2,205.75

Balance Due $2,205.75

Figure 15, Example of a Detail Reminder Statement

Previous Balance $2,205.75

Balance Due $2,205.75

Figure 16, Example of a Summary Reminder Statement
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Tracking Statements
The Pre-Bill Tracking program can be used to track statements to see where they are at in the billing
process. Pre-Bill Tracking uses records generated by running either Work-In-Process reports, or
running Draft statements.

Batch Numbers
Tabs3 Billing automatically assigns a unique batch number to each run of draft statements and each
Detail Work-In-Process Report for use by the Pre-Bill Tracking program. The previous batch number
is automatically incremented by “1,” regardless of whether a report or statement actually prints. The
batch number is shown in the Pre-Bill Tracking window. Specific batch numbers can be included in
the Pre-Bill Tracking window. Additionally, pre-bill tracking records can be deleted based on a batch
number.

More info: Steps on running a batch of statements can be found on page 17 of this guide.

Pre-Bill Tracking
Menu: Statements | Pre-Bill Tracking
Home: All Actions | Statements | Pre-Bill Tracking

The Pre-Bill Tracking program is used to review, modify, or delete the pre-bill tracking records that
have been created by running pre-bills or final statements. Either draft statements or Detail Work-in-
Process Reports can be used as pre-bills. This program makes it easy for the billing clerk to track the
status of individual client’s pre-bills and final statements. Records can be easily sorted for a specific
Primary, Secondary, or Originating timekeeper or a range of timekeepers.

If a pre-bill has been run for the client, the date shown on the most recent pre-bill is included in the
“Pre-Bill” column of the Pre-Bill Tracking window. If a final statement has been run for the client, the
date shown on the most recent final statement will be shown in the “Final” column. Pre-Bill Tracking
records can be marked as “on hold” or “reviewed.” Final statements can be printed for selected
clients from within the Pre-Bill Tracking window.

A Pre-Bill Tracking Report can be printed showing the pre-bill tracking records that meet specified
criteria.
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Figure 17, Pre-Bill Tracking window

Clicking the Options button in the Pre-Bill
Tracking window (Figure 17) displays a Pre-Bill
Tracking Options window (Figure 18) that lets
you specify exactly which pre-bill tracking
records to include in the window and on the Pre-
Bill Tracking Report. Options include the ability
to select the statements on hold, statements
outstanding (not reviewed), a specific batch
number, and which timekeepers to display.

Figure 18, Pre-Bill Tracking Options window

For example, let’s say that Mary prints draft statements for primary timekeeper 1 and gives them to
the attorney for approval. As the attorney returns the draft statements to Mary, Mary edits the
transactions as needed, and then she marks the statement as reviewed in the Pre-Bill Tracking
window. Mary can easily see which draft statements, if any, have not yet been returned and can
follow up with the attorney as needed. At any time, Mary can easily run final statement for any or all
of the clients with reviewed statements via the Pre-Bill Tracking window by clicking the Final
Statements button.
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Pre-Bill Tracking Report
The Pre-Bill Tracking Report is accessed from within the Pre-Bill Tracking program and includes the
pre-bill tracking records that are displayed at the time the report is run. The report can be sorted by
Client ID, Client Name, Description, Timekeeper, Pre-Bill Date, Hold Status, Reviewed Status, Final
Date, or Batch by clicking the column header in the Pre-Bill Tracking window. Clicking the Options
button (Figure 18) in the Pre-Bill tracking window allows you to select to print each timekeeper on a
new page if desired.

Date: 11/26/2018 Pre-Bill Tracking Report Page: 1
Jensen, Martin & Anderson, P.C.

Client Name Description Pre-Bill Hold Reviewed Final Batch Tkpr

100.00M Larson/Michael Larson v. Bel-Cor 11/15/2018 R 11/26/2018 44 1
101.00M Williams/John State v. Williams 11/15/2018 11/26/2018 45 2
121.01M Phillips/Marcus Real Estate Acquisition 11/15/2018 11/26/2018 45 1
200.01M Peterson Insurance Co. General Legal Counsel 11/15/2018 R 11/26/2018 45 1
200.02M Peterson Insurance Co. Maintenance of Insurance Policies 11/15/2018 45 3
415.00M MegaConstruction Corporation Corporate Merger - Megabuilders and BuilderCor 11/15/2018 45 3
850.00M White/Kelly Divorce 11/15/2018 45 5
850.02M White/Kelly Medical Care of Brianne 11/15/2018 45 2
850.01M White/Kelly Last Will & Testament 11/16/2018 46 5

Figure 19, Example of a Pre-Bill Tracking Report

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Pre-Bill Tracking Video
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Finalizing Statements
The processing of final statements is a two-step process. The first step consists of running a final
statement; the second step consists of updating the final statement by running the Update
Statements program.

Once a final statement has been generated, you are ready for a final review. You can optionally use
the Pre-Update Statements Report to review which clients will be updated. After reviewing which
clients’ statements will be updated, running the Update Statements program is a key step in the
billing process. The Update Statements program archives all transactions that were on the statement,
which means that payments are allocated appropriately, accounts receivable is up to date, and
transactions cannot be billed on another statement.

Pre-Update Statements Report
Menu: Statements | Pre-Update Statements Report
Home: All Actions | Statements | Pre-Update Statements Report

The Pre-Update Statements Report is used to print a report showing the amounts that have been
processed on final statements that are ready to be updated by the Update Statements program. The
report shows amounts for previous balance, fees, expenses, advances, finance charge, payments,
and balance due. The statement number and statement date shown on the final statement are
included for each client.

Date: 11/26/2018 Tabs3 Pre-Update Statements Report Page: 1
Jensen, Martin & Anderson, P.C.

Stmt # Client Name/Work Description Date Prev Bal Fees Expenses Advances Fin Chg Payments Bal Due

7615 100.00 Larson/Michael 11/26/2018 0.00 0.00 0.00 0.00 0.00 0.00 0.00 MLJ
Larson v. Bel-Cor

7618 101.00 Williams/John 11/26/2018 2,994.40 1,062.50 0.00 0.00 0.00 0.00 4,056.90 PAM
State v. Williams

7616 121.01 Phillips/Marcus 11/26/2018 5,748.85 2,337.50 0.00 0.00 0.00 -5,000.00 3,086.35 MLJ
Real Estate Acquisition

7617 200.01 Peterson Insurance Co. 11/26/2018 2,725.35 5,600.00 12.00 0.00 0.00 0.00 8,337.35 MLJ
General Legal Counsel

Total 11,468.60 9,000.00 12.00 0.00 0.00 -5,000.00 15,480.60

Figure 20, An example of the Pre-Update Statements Report

▶ To run a Pre-Update Statements Report

1. From the Statementsmenu, click Pre-Update Statements Report.

2. From the Client tab, enter the desired Client ID range.

3. Click OK.
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Update Statements Program
Menu: Statements | Update Statements
Home: All Actions | Statements | Update Statements

When the Update Statements program is run, all fee, cost, payment, and client funds transactions
that have been billed on final statements will be updated. You can update one client, a range of
clients, or all clients. You can update clients for a specific primary, secondary, or originating
timekeeper or a range of timekeepers. This program represents an important “turning point” in the
billing cycle. Final statements can be rerun as many times as required until the statement is as
desired. However, once the Update Statements program is run, it essentially finalizes the information
that was included on the client’s last final statement. These transactions are archived and are
removed from work-in-process.

Additionally, the information on the client’s last final statement is updated to accounts receivable
and various other productivity figures. Email statements can be emailed via the Email Statements
window once the attached final statements are updated.

Unallocated payments are allocated for
those clients being billed who previously
had no due amounts.

Figure 21, Update Statements window

▶ To update statements

1. From the Statementsmenu, click Update Statements.

2. Enter a Client ID range, or leave it blank to include all clients.

3. Optionally specify a Timekeeper range for which statements are to be updated.

4. Click OK.
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Tip: It is important to note that you must run the Update Statements program before running the
productivity and accounts receivable reports. The Update Statements program updates all billed
fees, costs, payments, and retainers (regardless of the Statement Date) to accounts receivable and
the client ledger file as well as the current month’s timekeeper, category, and transaction code
productivity figures. If productivity or accounts receivable reports are printed before updating, the
reports will not reflect the information from statements printed since the last time the Update
Statements program was run.

Undo Updated Statements
Menu: Statements | Undo Updated Statement | Undo Single Updated Statement

Statements | Undo Updated Statement | Undo Multiple Updated Statements
Home: Statements | Undo Single Updated Statement

When a statement is updated, it is finalized and many changes occur to the data files. The Undo
Updated Statements programs reverse these changes by restoring client data to its pre-update status
and unbilling the final statements that were run (i.e., the Status field for transactions on the
statements is changed back to “Print”). Updated statements for a specific client must be undone in
the reverse order they were updated.

Undo Single Updated Statement
The Undo Single Updated Statement
program can be used to undo a single
statement for a single client.

Figure 22, Undo Single Updated Statement window
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▶ To undo a single updated statement

1. From the Statementsmenu, point to Undo Updated Statement and select Undo Single
Updated Statement.

2. Enter the desired Client ID. The most recent Statement Number is automatically selected.

3. Click OK.

Undo Multiple Updated Statements
Undo Multiple Updated Statements
program can be used to undo statements
for multiple clients with the same
statement date.

Figure 23, Undo Multiple Updated Statements window

▶ To undomultiple updated statements

1. From the Statementsmenu, point to Undo Updated Statement and select Undo Multiple
Updated Statements.

2. Enter the Statement Date of the statements you want to be undone.

3. Enter any other desired criteria.

4. Click OK.

Unbill Final Statements
Menu: Statements | Unbill Final Statements
Home: Statements | Unbill Final Statements
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The Unbill Final Statements program allows you to reverse a final bill if it has not yet been updated.
This feature is useful when a client is unintentionally billed or you decide not to bill a client already.

When a final statement is run, Tabs3 Billing “tags“ the transactions as “ready to be updated.“ 
Unbilling effectively “untags“ the transactions so they remain in work-in-process and do not get
updated. The field that is tagged is the Status field. When transactions are entered, they are typically
entered with a “P - Print“ status. When a final statement is run, the transaction is changed to “U -
Update“ indicating the transaction is ready to be updated. Unbilling the final statement changes the
status of all transaction that were on the final statement from “U - Update“ back to “P - Print“ 
thereby canceling the final statement.

Unbilling statements must be done prior to running the Update Statements program. If a final
statement has already been updated, then you must use the Undo Updated Statement program to
reverse the update process.
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Emailing Statements
When statements are generated, statements for clients who are configured to receive mail
statements will be sent to the printer, whereas statements for clients who are configured to receive
email statements will be sent to the Email Statements window. Statement delivery options are
configured in the Statement Delivery Options of the Client file (page 3). Once email messages and
statements have been reviewed and updated, they can be automatically sent from the Email
Statements window.

The ability to email statements from Tabs3 Billing requires either Microsoft Outlook or an SMTP
server and is designated on theMain tab of Tabs3 Billing Customization. If you select Outlook, no
further setup is required. If you select SMTP, you must configure the SMTP server in System
Configuration using the Settings | Outgoing Email Configuration program.

More Info: For additional information on emailing statements, see Tabs3 Billing Help or
Knowledge Base Article R11338, “Emailing Tabs3 Statements.“

Note: You can include a variable for a ProPay payment link in your email message, which allows
clients to pay their bill online with a credit card, debit card, or eCheck. See Knowledge Base Article
R11767, “Using the Tabs3 Payment Link,” for more information.

Email Statements Window
Menu: Statements | Email Statements
Home: All Actions | Statements | Email Statements

Use the Email Statements window to manage email statements; you can preview the email message
that accompanies the statement and edit the To, Cc, Bcc, Subject, and Body fields, review the PDF
statement, mark the statement as reviewed or on hold, and send the statement from this window.

Figure 24, Email Statements window
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Options The Options button can be used to display the Email
Statements Options window (Figure 25), which allows you
to limit the records shown in the Email Statements window
based on Client ID or Primary Timekeeper. This window
also allows you to display only email statements within a
specific Statement Date range.

Refresh The Refresh button or F5 can be used to update the
information shown in the Email Statements window. Any
clients that no longer meet the email statements options
will be removed. New final statements that have been run
for clients will replace the original PDF statements, except
when statements have been updated or are open at the
time of the refresh.

Hold TheHold button can be used to mark the selected records
as “on hold.“ Check marks will be placed in theH (Hold)
column and the R (Reviewed) column. If the record was
already on hold, the check marks will be removed from the
H (Hold) and R (Reviewed) columns.

Reviewed The Reviewed button can be used to mark the selected
records as “reviewed.“ A check mark will be placed in the
R (Reviewed) column. If the record was already marked as
reviewed, the check mark will be removed from the R
(Reviewed) column.

View/Edit Email The View/Edit Email button can be used to open the Email
Preview window (Figure 26) to review and edit the email as
well as view the attachment(s) that will be sent to the
client. The body of the email is determined by the Email
Template assigned to the client. The Email Preview window
can also be used to send the email, or mark the email as
“on hold“ or “reviewed.“

More Info: Additional information on creating Email
Templates can be found in Tabs3 Billing Help and the
Statement Formatting Guide.
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Send Reviewed The Send Reviewed button sends all email statements that
have a check mark in the R (Reviewed) column of the
Email Statements window. Only statements that have been
updated can be sent. Therefore, if any statements in the
Email Statements window have been reviewed, but not
updated, you will be prompted to update statements
before the email statements are sent.

Any statements that have a check mark in theH (Hold)
column along with a check mark in the R (Reviewed)
column will not be sent until the hold status is removed.

Figure 25, Email Statements Options window
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Figure 26, Email Preview window

Email Statements Report
Menu: Statements | Email Statements Report
Home: All Actions | Statements | Email Statements Report

The Email Statements Report shows all email statements that are successfully sent to clients who are
set up to receive email statements. For each email that meets the selected criteria, the client, email
date, recipient information, file name, statement date, and User ID of the sender are included in the
report, as shown in Figure 30.
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Figure 27, Email Statements Report
Client tab

Figure 28, Email Statements Report
Options tab

Figure 29, Email Statements Report
Sort tab
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Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Options tab The Options tab allows you to specify a range of contacts,
statement dates, email dates, or user IDs.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

Date: 11/26/2018 Tabs3 Email Statements Report Page: 1
Jensen, Martin & Anderson, P.C.

Email Date Contact Email Address PDF File Name Stmt Date User ID

100.00 Larson/Michael
RE: Larson v. Bel-Cor

11/16/2018 Michael Larson mlarson@larson.com 100.00_Stmt_7619.pdf 11/15/2018 RON

101.00 Williams/John
RE: State v. Williams

11/16/2018 John Williams jw2000@net.com 101.00_Stmt_7622.pdf 11/15/2018 RON

415.00 MegaConstruction Corporation
RE: Corporate Merger - Megabuilders and BuilderCorp

11/16/2018 James R. Tatiki, Sr. jt@megaconcorp.com 415.00_Stmt_7624.pdf 11/15/2018 RON

850.00 White/Kelly
RE: Divorce

11/16/2018 Kelly Ann White kelly_white_la@hushmail.com 850.00_Stmt_7625.pdf 11/15/2018 RON
11/16/2018 Kelly Ann White kelly@homeoffice.net 850.00_Stmt_7625_Dup.pdf 11/15/2018 RON

850.02 White/Kelly
RE: Medical Care of Brianne

11/16/2018 Kelly Ann White kelly@homeoffice.net 850.02_Stmt_7623.pdf 11/15/2018 RON

Figure 30, Example of the Email Statements Report

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Emailing Statements Video
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Reprinting Statement Information
There are several methods for reprinting information that was included on a statement, depending
on the type of information you want. In this section, we will cover the Reprint Updated Statements
program, the Client Ledger Report, and the Transaction File List.

Reprint Updated Statement
Menu: Statements | Reprint Updated Statements | Reprint Single Updated Statement

Statements | Reprint Updated Statements | Reprint Multiple Updated Statement
Home: All Actions | Statements | Reprint Single Updated Statement

The Reprint Single Updated Statement and Reprint Multiple Updated Statements programs allow you
to reprint a statements that has been updated. This enables you to easily reproduce previously billed
statements from any period.

Reprint Single Updated Statement
The Reprint Single Updated Statement
program allows you to reprint statements
one at a time.

Figure 31, Reprint Single Updated Statement window

▶ To reprint a single updated statement

1. From the Statementsmenu, point to Reprint Updated Statements and select Reprint Single
Updated Statements.

2. Enter the Client ID for which you want to reprint a statement.
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3. Select the Statement Number of the statement to reprint.

4. Click OK.

Reprint Multiple Updated Statements
The Reprint Multiple Updated Statements
program allows you to reprint multiple
statements at one time.

Figure 32, Reprint Multiple Updated Statements window

▶ To reprint multiple updated statements

1. From the Statementsmenu, point to Reprint Updated Statements and select Reprint
Multiple Updated Statements.

2. In the Statement Criteria section, enter the desired criteria.

3. In the Reprint Options selection, optionally select to generate PDFS as Individual
Statements.

4. Click OK.

Client Ledger Report
Menu: Reports | Client Reports | Client Ledger Report
Home: All Actions | Reports | Management Reports | Client Ledger Report

The Client Ledger Report shows the amount of payments, fees, expenses, advances, finance charge,
fee sales tax, expense sales tax, advance sales tax, and balance due for each statement. Payment
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activity (including payment reversals), write offs, and balance due information are also included.
Detailed billed information that shows amounts billed by timekeeper and Cost Type can optionally
be included on the detail reports. A report showing only write offs can be generated.

The following tabs are available in the Client Ledger Report:

Figure 33, Client Ledger Report
Client tab

Figure 34, Client Ledger Report
Options tab

Figure 35, Client Ledger Report
Format tab

Figure 36, Client Ledger Report
Sort tab
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Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify what
type of information is included on the report (e.g., include
zero balance clients, detail information for each statement,
write offs only, etc.).

Format tab The Format tab allows you to optionally include
information such as reference numbers, hours, bill total,
and balance due as well as specify whether the report will
print portrait or landscape.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

▶ To run a Client Ledger Report

1. From the Reportsmenu, select Client Reports, and then click Client Ledger Report.

2. On the Client tab, select the desired Client ID or range of clients.

3. On the Options, Format, and Sort tab, select any other desired options.

4. Click OK.

Training Videos
You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Client Ledger Report Video

Transaction File List
Menu: Reports | Transaction Reports | Transaction File List
Home: All Actions | Reports | Transaction Reports | Transaction File List
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The Transaction File List is one of our most flexible reports and can be used to determine which fees,
costs, and payments have been final billed and updated based on various options. The Transaction
File List is a means of sorting and listing fee, cost, and payment transactions stored in Tabs3 Billing.
This report can be used as an alternative to reprinting individual statements, as it can be configured
to print all final billed and updated transactions subtotaled in Statement Date order.

The following tabs are available in the Transaction File List:

Figure 37, Transaction File List
Client tab

Figure 38, Transaction File List
Transactions tab

Figure 39, Transaction File List
Options tab

Figure 40, Transaction File List
Format tab
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Figure 41, Transaction File List
Sort tab

Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Transactions tab The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs, or payments), date, transaction code, working
timekeeper, category, and cost type.

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify the type
of transactions you want to include on the report.

Tip: Be sure to select the Archived check box. Selecting
this option includes transactions on the report that have
been final billed and updated.

Format tab The Format tab allows you to specify which columns you
want to include and if you want to print the report in
portrait or landscape orientation. All columns are optional,
but at least one column must be selected.

- 41 -



Tabs3 Billing Statements Guide

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

▶ To run a Transaction File List for statements

1. From the Reportsmenu, select Transaction Reports, and then click Transaction File List.

2. On the Client tab, select the desired Client ID or range of clients.

3. On the Transactions tab, leave everything blank.

4. On the Options tab, in the Transaction section, clear theWork-In-Process check box and
select the Archived check box.

5. In the Date Selection section, select Statement.

6. On the Format tab, select the Statement Date check box.

7. On the Sort tab, in the 1st Sort Order section, select Client and select the Subtotal check
box,

8. In the 2nd Sort Order section, select Statement Date and select the Subtotal check box.

9. Click OK to print the report.

This is just one of the many ways to run the Transaction File List.

Date: 11/26/2018 Detail Transaction File List Page: 1
Jensen, Martin & Anderson, P.C.

Trans H Tcode/ Stmt # Hours
Client Date Tmkr P Task Code Rate to Bill Amount

Client ID 101.00 Williams/John
101.00 08/28/2018 1 A 19 250.00 0.30 75.00 Initial Client Meeting

Subtotal for Statement Date 08/26/2018 Billable 0.00 0.00
Non-billable 0.30 75.00

Total 0.30 75.00

101.00 09/14/2018 1 A 18 250.00 2.50 625.00 Prepared for conference with client.
101.00 09/19/2018 2 A 250 5.75 Long distance telephone charges.
101.00 09/21/2018 1 A 251 7.50 Photocopy charges.
101.00 09/21/2018 2 A 250 10.50 Long distance telephone charges.
101.00 09/21/2018 2 A 253 2.90 Postage.
101.00 09/24/2018 1 A 250 6.75 Long distance telephone charges.
101.00 09/25/2018 1 A 3 250.00 0.25 62.50 Telephone conference with client.
101.00 09/28/2018 1 A 253 2.50 Postage.

Subtotal for Statement Date 09/25/2018 Billable 2.75 723.40

101.00 10/23/2018 3 A 255 1.25 Facsimile costs.
101.00 10/26/2018 1 A 9 250.00 3.00 750.00 Review and analyze case status.
101.00 10/26/2018 1 A 1 250.00 0.50 125.00 Legal Research.
101.00 10/26/2018 1 A 10 250.00 1.50 375.00 Legal research.
101.00 10/26/2018 A 900 1,076.60 Payment
101.00 10/26/2018 2 A 251 7.35 Photocopy charges.
101.00 10/26/2018 3 A 251 30.00 Photocopy charges.
101.00 10/26/2018 3 A 102 47.50 Courier fee (325) Professional Messenger Services
101.00 10/29/2018 2 A 106 4.00 Online legal research (300) Thomson Reuters Payment

Center

Subtotal for Statement Date 10/26/2018 Billable 5.00 1,340.10
Payments 1,076.60

Total for Client ID 101.00 Billable 7.75 2,063.50 Williams/John
Non-billable 0.30 75.00 State v. Williams

Total 8.05 2,138.50
Payments 1,076.60

GRAND TOTALS

Billable 7.75 2,063.50
Non-billable 0.30 75.00

Total 8.05 2,138.50
Payments 1,076.60

Figure 42, Example of a Transaction File List
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Training Videos
You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via theHelp |
Training Videosmenu and at Tabs3.com/t3video.

Transaction File List Video
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Conclusion

Resources
Additional information on the features discussed in this guide can be found in the Tabs3 Billing
Help. Simply press F1 from anywhere within the software to load the Help information for that
particular topic.

Guides and Sample Statements
Additional guides and resources for separate software features are also available, including the
following:

l Statement Formatting Guide - This guide provides the information on the tools to give your
statements the look you want.

l BillingMethods Guide - This guide provides information on the various methods of billing
clients that are available in Tabs3 Billing. It includes information on basic billing concepts
that are important to individuals who enter client information in Tabs3 Billing.

l Tabs3 Billing Sample Reports - Over 20 pages of sample statements, and the formatting
options that were used to create the statements, can be found in the Tabs3 Billing Sample
Reports.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.

l R11582 - “Statements Information Resources“, is a comprehensive list of KB Articles
containing more information about Tabs3 Billing statements.

l R11338 - Emailing Tabs3 Statements

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com
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Training Videos
Tabs3 includes numerous training videos to help you learn the software. Training video libraries can
be accessed via the software from theHelp | Training Videosmenu option.

The following training videos contain information on generating statements. Clicking a link will open
the associated training video in your browser.

Statements Overview Video

Client Overview Video

Write-Up/Down Fees and Costs Video

Flat Fee Billing Video

Split Billing Video

Detail & Summary WIP Reports Video

Pre-Bill Tracking Video

Emailing Statements Video

Client Ledger Report Video

Transaction File List Video
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